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Power bar
The Intime Power bar is a menu system that always remains visible infront of other applications 
and is used to run applications that form part of the Intime suite of programmes.

To run the Power bar double click on the following icon 

The following will be visible in the top right of the screen and can be used to run applications by 
clicking on the relevant icons

The icons run the following applications :-

Intime
Calendar
Alarm
Calculator
Clock
Iconeditor
Close / Exit the Power bar. 



Editor: File Menu

New

This command clears the editing area to start a new icon.    The new icon appears in the 
iconbox selected the Status Area.

If there are any unsaved changes in the editing area when you select the New 
command, IconEdit asks if you want to save the changes.    IconEdit then clears the 
editing area to the currently selected screen color and changes the Title bar to [Untitled].

Open

This command opens the IconEdit Viewer so you can select an icon for editing.    When 
you double-click the name of an icon in the Viewer, IconEdit opens the selected icon in 
the Editor.

Save

This command saves changes made to the icon in the editing area.    If the Title bar 
shows that the icon is untitled, the Save icon dialog box appears so you can give the 
icon file a name.

Save As

This command saves the icon in the editing area.    The Save icon dialog box appears 
so you can save the icon with a different file name.

Exit

This command closes the IconEdit Editor.    If any of the six icons in the Status Area 
have unsaved changes, IconEdit prompts you to exit any way or cancel the Exit 
command.    If the Viewer is also open, IconEdit lets you close the Viewer too if you 
started the Viewer after the Editor



Editor: Edit Menu

Undo

This command removes any changes from the icon since the time you changed editing tools or 
selected another icon.    Once you select a new tool or another icon from the Status Area, the 
Undo command cannot remove the changes made in the editing area.    The Undo icon button in
the Status Area displays the condition the icon will return to if you select the Undo command.

Cut

This command copies the portion of the editing area you select to the Clipboard and clears the 
selected area to the current screen color.    The Cut command does not work if you move the 
part of the icon you select before cutting it.    You must reselect the area you want to cut then 
use the Cut command.

Copy

This command copies the portion of the editing area you select to the Clipboard.    The editing 
area is not affected.    The Copy command does not work if you move the part of the icon you 
select before copying it.    You must reselect the area you want to cut then use the Copy 
command.

Paste

This command inserts the contents of the Clipboard as a selected group of pixels in the upper-
left 
corner of the editing area.    You can then move the selected pixels anywhere in the editing area 
before pasting them in the current icon.    To paste the selection into the icon, click the mouse 
anwhere in the editing area outside of the selection.

All pixels in the pasted bitmap that match the current screen color appear transparent and do 
not affect the icon below.    Pixels that match the inverse of the screen color replace the pixels in
the icon.

Paste Opaque

This command inserts the contents of the Clipboard as a selected group of pixels in the upper-
left 
corner of the editing area.    You can then move the selected pixels anywhere in the editing area 
before pasting them in the current icon.    To paste the selection into the icon, click the mouse 
anwhere in the editing area outside of the selection.

All pixels in the bitmap cover any pixels in the icon below.

Delete

This command deletes the selection in the editing area from the icon, replacing the selection 
with the current screen color.



Select All

This command selects the entire icon in the editing area.    You can also double-click the Select 
tool to select the entire icon.

Flip Horizontal / Vertical

This command flips the current selection in the editing area from left to right.

Once you select part of the icon with the Select tool, you can flip the selected pixels either 
vertically or horizontally.    You can use the Flip Horizontal and Flip Vertical commands in the 
Edit menu.    You can also use these shortcut keys:

Flip Horizontal CTRL+H
Flip Vertical CTRL+V

The selection does not have to be square in order to be flipped.    You can also flip a selection 
while it is being moved.

Invert

This command changes all the colors in the current selection to their opposites.    The following 
picture shows the normal color palette in IconEdit and the inverted color palette so you can see 
how the colors change when using the Invert command.



Editor: View Menu

Status Bar

This command hides or displays the Status Area.    This command is unavailable if the Editor 
window is too small to display the Status Area.

Tool Palette

This command hides or displays the Tool Palette.    This command is unavailable if the Editor 
window is too small to display the Tool Palette.

Color Palette

This command hides or displays the Color Palette.    This command is unavailable if the Editor 
window is too small to display the color palette.

Zooming Scroll bar

This command hides or displays the Zooming Scroll bar.

The vertical scroll bar along the left side of the editing area increases or decreases the 
magnification of the currently selected icon.

You can use this scroll bar to display the icon at actual size or magnify it to fill the editing area.    
When you resize the Editor, the scroll bars adjusts to the new window size so that the icon stays
at the same magnification.

Show All

This command displays all hidden Editor controls: The Status Area, Tool Palette, Color Palette, 
and Zooming Scroll bar.    If the Editor window is too small to display a specific control, that 
control remains hidden.

Grid

This command turns the grid on and off.    The grid helps you tell individual pixels apart in the 
editing 
area.    When the grid is on you can select between a solid line grid or a dotted grid.

Line Grid

This command displays the grid as solid lines.    This command is unavailable when the grid is 
turned off.

Dotted Grid



This command displays the grid as rows and columns of dots.    This command is unavailable 
when the grid is turned off.

Zoom In

This command magnifies the appearance of the icon in the editing area.    You can also zoom in 
on an icon with the Zooming Scroll bar.

Zoom Out

This command reduces the appearance of the icon in the editing area.    You can also zoom out 
from an icon with the Zooming Scroll bar.

Focus to Editor on Drag and Drop

When switched on this command automatically brings the Editor to the foreground any time an 
icon is dragged from the Viewer and dropped onto the Editor.    When switched off you can drag 
up to six icons from the Viewer and drop them on iconboxes in the Status Area without bringing 
the editor to the foreground each time.

Display Border on Selected Icon

This command displays or hides a narrow border showing the edge of the selected icon in the 
Status Area.

Pop-up Tools menu

When switched on this command lets you pop-up the Tools menu when you click the right 
mouse button to the left or right of the editing area.



Editor: Tools Menu

How to Select a Tool

You can select tools in the Editor in either of two ways:

1. Clicking on the icon for the tool in the Tool Palette
2. Selecting the name of the tool from the Tools menu

Select Tool

This tool selects a rectangular region in the editing area.

To use the Select tool, click in the editing area to anchor one corner of the area you want to 
select.    
Drag the mouse until the flexible box that appears surrounds the area you want to select.    
Release the mouse button.    If you make a mistake while selecting, click outside of the current 
selection and start over.

Paint Tool

This tool paints pixels in the editing area according to the selected brush size.
To use the Paint tool, click the mouse in the editing area and drag to begin painting.

Fill Tool

This tool fills a closed area with the color selected in the Color Palette.
To use the Fill tool, click in the area to be filled.    The area will be filled with the color selected in 
the 
Color Palette.    The Fill tool fills adjacent pixels which are the same color as the starting pixel.    
If you fill an area with a dithered color rather than solid color, the result will be a checkerboard 
pattern.

Line Tool

This tool draws straight lines.
To use the Line tool, click in the editing area to anchor one end of the line.    Drag the mouse 
until the mouse reaches the other end of the line you want to draw.    Release the mouse button 
to draw the line in the icon.    The width of the line corresponds to the current brush size.    The 
color of the line is the color selected in the Color Palette.

To draw a horizontal, vertical, or diagonal line, hold down the SHIFT key as you drag the mouse.

Square Tool

This tool draws rectangles and squares.
To use the Square tool, click in the editing area to anchor one corner of the square.    Drag the 
mouse until the square is the size and shape you want.    When the square or rectangle is the 
right size and shape, release the mouse button.    The brush size determines width of the box's 



border.    The color of the outline of the square is determined by the Color Palette.
To draw a perfect square, hold down the SHIFT key as you drag the mouse.

Filled Square Tool

This tool draws filled rectangles and squares.
To use the Filled Square tool, click in the editing area to anchor one corner of the square.    Drag
the 
mouse until the square is the size and shape you want.    When the square or rectangle is the 
right size and shape, release the mouse button.    The brush size determines width of the box's 
border.    The color that fills in the square is determined by the Color Palette.
The border of the square is a line and therefore cannot be drawn using dithered colors.    If you 
select a dithered color the border of the square will appear in the nearest solid color.    If you 
want the entire square to be drawn with a dithered color, first draw the square with a solid color 
then use the Fill tool to fill it in with the desired dithered color.

To draw a perfect square, hold down the SHIFT key as you drag the mouse.

Circle Tool

This tool draws circles and ellipses.
To use the Circle tool, click in the editing area to anchor one corner of a flexible box containing 
an 
ellipse.    The box appears while you draw to show the anchor point and current mouse position. 
It 
disappears when you finish drawing.    Drag the mouse until the ellipse is the size and shape 
you want.    
When the circle or ellipse is the right size and shape, release the mouse button.    The brush 
size 
determines the border width of the circle or ellipse border.    The color of the circle or ellipse 
border is determined by the Color Palette.

To draw a perfect circle, hold down the SHIFT key as you drag the mouse.

Filled Circle Tool

This tool draws filled circles and ellipses.
To use the Filled Circle tool, click in the editing area to anchor one corner of a flexible box 
containing an ellipse.    The box appears while you draw to show the anchor point and current 
mouse position.      It disappears when you finish drawing.    Drag the mouse until the ellipse is 
the size and shape you want. When the circle or ellipse is the right size and shape, release the 
mouse button.    The brush size determines the border width of the circle or ellipse border.    The 
color that fills the circle or ellipse is determined by the Color Palette.

To draw a perfect circle, hold down the SHIFT key as you drag the mouse.
The border of the ellipse is a line and therefore cannot be drawn using dithered colors.    If you 
select a dithered color the border of the ellipse will appear in the nearest solid color.    If you 
want the entire ellipse to be drawn with a dithered color, first draw the ellipse with a solid color 
then use the Fill tool to fill it in with the desired dithered color.



Editor: Icon Menu
Enables you to select and display an icon from the Status Area when it is not displayed.

Choose... To select and display the icon from...
1 - [path]    Filename the upper-left iconbox
2 - [path]    Filename the upper-right iconbox
3 - [path]    Filename the middle-left iconbox
4 - [path]    Filename the middle-right iconbox
5 - [path]    Filename the lower-left iconbox
6 - [path]    Filename the lower-right iconbox

The full path and filename of the currently loaded icons appear in the appropriate menu item.    
Selecting an 
icon from the Icons Menu is equivalent to clicking the corresponding iconbox in the Status Area.



Editor: Colour Menu

Colors

This command opens the Custom Color Palette Window, where you can define custom colors 
and 
assign them to the current color palette.    You can use the Custom Color Palette window to 
select colors in the same way you select colors with the Color Palette displayed in the Editor.    
You can display your custom Color Palette as a floating palette instead of the Color Palette in 
the Editor.

Default Color Palette

This command resets the Color Palette to the default colors.

INI File Color    Palette

This command sets the Color Palette to the values currently stored in the ICONWRKS.INI file.    
If this file doesn't exist, or you have never saved changes to the displayed Color Palette, the 
color palette resets to the default colors.

Solid Colors Only

This command sets the current color palette to solid colors only.    Each column of cells is set to 
the same color.    Because some tools cannot use dithered colors, this command ensures that 
any color you select can be used by any tool.

Save Color Palette to INI file

This command saves the current color palette to ICONWRKS.INI.    IconEdit creates this file If it 
doesn't exist.

Left/Right Colors

This command sets the current mouse colors to those currently displayed in the Status Area for 
the Left and Right colors.    You can also set the current mouse colors by selecting the 
corresponding option button in the Status Area.

Screen/Inverse Colors

This command sets the current mouse colors to those currently displayed in the Status Area for 
the Screen and Inverse colors.    You can also set the current mouse colors by selecting the 
corresponding option button in the Status Area.



Editor: Brushes Menu

Brushes

Choose... To set drawing tool size to...
Small (1 x 1) 1 pixel wide
Medium (3 x 3) 3 pixels wide
Large (5 x 5) 5 pixels wide

The brush size does not affect the Select tool or Fill tool.



Editor: Moving a Selection
Once a region in the icon has been selected with the Select tool, there are two ways to move it:

Opaque Move Use the right mouse button to click and drag the selected pixels.    The selection 
is moved as is, including all foreground coloured pixels and all screen and inverse screen 
coloured pixels.

Transparent Move, use the left mouse button to click and drag the selected pixels.    Only the 
foreground coloured pixels move.    This lets you move regions in the icon that appear to be a 
non-rectangular.

Once you move a selection of pixels, the selection rectangle changes from a dotted rectangle to
a solid rectangle.

Holding down the SHIFT key while moving a selection leaves a copy of the selected pixels at 
their original location.    Selecting another tool or selecting another icon also deposits the moved 
pixels to their current location.



Editor: Testing an Icon
You can test the icons you create to see what they look like when dragged.    This ability is 
especially helpful when your icon contains transparent regions.

To test an icon, drag the icon from its icon box in the Status Area.    You can test only the 
currently selected icon. You cannot drop icons dragged from the Status Area.



Viewer: File Menu

Open

This command opens the IconEdit Editor and loads the currently selected icon it for editing.    
There are several ways to select and load an icon into the Editor.    The menu item is active only 
when an icon is selected.

Exit

This command closes the IconEdit Viewer.    If the Editor is open and the Viewer was started 
first, you will be asked if you also want to close the Editor.    If the Editor was started first, the 
Viewer will be closed leaving the Editor running.



Viewer: Edit Menu

Copy to Clipboard

This command copies the bitmap image of the selected icon onto the Clipboard.    The icon itself
is not copied to the Clipboard.      The Copy command is unavailable if you haven't selected an 
icon.



Viewer: Options Menu

Editor

This command opens the IconEdit Editor without loading an icon.    If the Editor is already 
opened, this command brings it to the foreground.

Show all Icons

This command displays all of the icons listed in the Icons list box in the scrollable viewing 
window to the right.

Show all icons on DIR. Change Command

This command causes IconEdit to update the scrollable viewing area whenever you change 
directories in 
the Viewer.



Viewer: Selecting an Icon to Edit
There are several ways you can select an icon from the Viewer to open in the Editor:

Drag the from the Viewer and drop it on the editing area or on one of the six icon boxes in the 
Status Area of the Editor.
Double-click a filename in the file list box.
Clicking a filename in the file list box then press ENTER.
Enter the name directly into the filename text box then press ENTER.
Select an icon then choose the Open command from the File menu.



Viewer: Viewing Icons

Viewing Individual Icons

You can view individual icons one at a time, by selecting them from the Icons list box.    The 
selected icon appears beside the Selected Icon label.

Icons that aren't valid under Windows appear as solid black squares.

Viewing All Icons in a Directory

To view all the icons in a directory at the same time, choose the Show all Icons command from 
the Options menu.    Each of the icons in the current directory appears in the viewing area to the 
right of the list.    You can scroll the viewing area if not all the icons in the directory fit in the 
viewing area.    You can also resize the Viewer window to increase the size of the viewing area.

IconEdit clears the viewing area when you change the current directory unless you switch on 
the Show all icons on DIR. Change command in the Options menu.



Setup
It is recommended that all files with the extension .DLL and .VBX should be placed into the 
Windows System directory i.e. 
C:\WINDOWS\SYSTEM

It is recommended that all other files be placed in a directory called Intime on the C: drive i.e. 
C:\INTIME

Load the following Icons on to the Program Manager

Intime Menu System

Icon Editor / Viewer

IconEdit Help

Should you encounter problems ensure that share is loaded this will enable file    sharing which 
is sometimes required in a Windows environment. This is only required on windows version 3.1 
or below.

Make sure that share is in the path or the path to the file is included i.e.

Enter the following line in the Autoexec.bat file

                C:\DOS\SHARE.EXE /L:500 /F5100

A Space is required before the / 



Help
Obtaining Help

Help can be accessed from the Help Menu or by pressing F1

About

Should you require further information select the About menu to Display the About screen which
details the Address and Telephone number of Quest technology

Please note that Telephone support can be a chargeable service.



Hardware
 Recommended system requirements.
    
      IBM or 100% Compatible Personal Computer

      Hard Disk. 8 Megabytes Min.
      
      Windows 3.1 and MSDOS 5.
      
      386 or above Processor and 4 Megabytes of RAM 8 recommended. (the more the better)
      
      Colour VGA screen + 256 colour display.




